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About the Relative Quantification
Analysis Module

The Relative Quantification Analysis Module for QuantStudio™ Design and Analysis Software v2 is used
determine the relative quantity of a target of interest in a test sample relative to a reference sample. The

analysis module supports relative quantification using either comparative C; (AACy) analysis or relative
standard curve analysis.

For more information about relative quantification analysis, see Chapter 5, “About relative quantification
analysis”.
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Workflows for relative quantification
analysis

Workflow: Relative standard curve analysis

Set up a plate file for relative quantification analysis (page 9)

Select a system template or existing plate file to set up a new plate file (page 9)

v

Confirm or edit the run method for relative quantification analysis (page 10)
v

Confirm or edit the plate setup for relative quantification analysis (page 10)
v

Review and save the plate file (page 15)

v

Perform relative quantification analysis (page 17)

Review results in the Amplification Plot (page 17)
v
Select the Relative Quantification Analysis Module (page 17)
v
Review results in the Standard Curve Plot (page 17)
v
Review results in the Gene Expression Plot (page 18)
v
(Optional) Review results in the Endogenous Plot (page 19)
v
(Optional) Omit outliers from relative quantification analysis (page 21)
v

(Optional) Review dye signal profile in the Multicomponent Plot (page 21)
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Chapter 2 Workflows for relative quantification analysis ~ [
Workflow: Relative standard curve analysis

v
(Optional) Review signal profile in the Raw Data Plot (page 21)
v

(Optional) Edit relative quantification analysis settings (page 22)
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M Chapter 2 Workflows for relative quantification analysis
Workflow: Comparative Ct analysis

Workflow: Comparative C; analysis

Set up a plate file for relative quantification analysis (page 9)

Select a system template or existing plate file to set up a new plate file (page 9)

v

Confirm or edit the run method for relative quantification analysis (page 10)
v

Confirm or edit the plate setup for relative quantification analysis (page 10)
v

Review and save the plate file (page 15)

v

Perform relative quantification analysis (page 17)

Review results in the Amplification Plot (page 17)

v

Select the Relative Quantification Analysis Module (page 17)
v

Review results in the Gene Expression Plot (page 18)
v
(Optional) Review results in the Endogenous Plot (page 19)
v
(Optional) Omit outliers from relative quantification analysis (page 21)
v
(Optional) Review dye signal profile in the Multicomponent Plot (page 21)

v

(Optional) Review signal profile in the Raw Data Plot (page 21)
v

(Optional) Edit relative quantification analysis settings (page 22)

8 QuantStudio™ Design and Analysis Software v2 Relative Quantification Analysis Module User Guide



Set up a plate file for relative
quantification analysis

For detailed instructions about setting up a plate file, see @ Help » Help Contents.

Select a system template or existing plate file to set up a
new plate file

A plate file contains the information that is necessary to perform an instrument run, including instrument
setup, run method, plate setup, and analysis setting.

A system template is a non-editable plate file that is included with the software.
A new plate file must be created from a system template or a previously created plate file.

For detailed information about system templates and plate files, see @ Help » Help Contents.

1. In the home screen, click & Set Up Plate.
The Plate Gallery opens to the System Templates tab.

2. IMPORTANT! Select a system template or a plate file that corresponds to your instrument, block,

and run mode. These properties are not editable after the plate file has been created.

In the left pane, select the appropriate options to filter the system template and plate file lists.
* Instrument
* Block
¢ Run Mode
* Analysis

Note: Thermal protocol, plate setup, and post-run analysis options are independent of
analysis module selection. Analysis module selection can be changed at any point during
plate file set or post-run analysis (see “Select the Relative Quantification Analysis Module” on
page 17).
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P2  Chapter 3 Set up a plate file for relative quantification analysis
Confirm or edit the run method for relative quantification analysis

3. Navigate to, then select a system template or plate file.

Tab Description
System Contains system templates, non-editable plate files that are included with the
Templates software.

Select a system template to automatically generate a new plate file that can be
edited, then saved.

My Plate Files | Contains plate files that were previously saved to My Plate Files. plate files that are
included with the software.

Select an existing plate file to edit, then save, or to save as a new plate file.

Recents Contains plate files that were recently opened. Recently opened plate files from
System Templates and My Plate Files do not populate this tab.

Select an existing plate file to edit, then save, or to save as a new plate file.

Note: To view all options for opening the plate file, hover over the plate file, then click ---
(Actions).

Selecting the location where the file is saved is a controlled function. If the Browse button in the
Save As dialog box is inactive, the security has been enabled in the software. The user role does
not have the permission to select the location where the file is saved. The user role must have the
permission of Edit Save As Destination.

The plate file opens in the Run Method tab.

Confirm or edit the run method for relative quantification
analysis

For most analysis, the default run method is appropriate. The following options are compatible for
relative quantification analysis.

* PCR
¢ 1-step RT-PCR
e 2-step RT-PCR

* In a plate file, in the Run Method tab, adjust the run method elements as needed.
For detailed instructions about editing the run method, see @ Help » Help Contents.

® C(Click --- (Actions) » Filter Settings to confirm or edit filter settings.

Confirm or edit the plate setup for relative quantification
analysis

For detailed instructions about plate setup, or to download example plate setup files, see
® Help » Help Contents.
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Chapter 3 Set up a plate file for relative quantification analysis B
Confirm or edit the plate setup for relative quantification analysis

Add samples and assign to wells: relative standard curve analysis

For detailed instructions about plate setup, see @ Help » Help Contents.

Note: Multiple targets can be assayed using relative standard curve analysis, but each target requires
its own standard curve. To set up the standard curve using the Standard Curve Wizard see “Set up the
standard curve” on page 12.

1. In the Plate Setup tab, add samples and assign to wells using the following options.

* |Import a plate setup file
* Manually add samples to the Samples table
* Manually add samples to wells in the plate layout

2. Confirm or edit sample information in the Samples table.

Column Description
Name Sample name
Color Sample color
Typelll Relative standard curve analysis uses the following sample types.

¢ Standard

Note: You must enter the quantity for each standard sample in the Quantity
column.

* Unknown—test and reference samples

Note: To identify a sample as the reference sample, see “(Optional) Edit relative
quantification analysis settings” on page 22.

* Negative Control

Quantity Note: The quantity entered for a standard sample in the Samples table is used
(standard to populate the Quantity column for standard tasks in the Targets table (see “Add
samples only) | targets and assign to wells” on page 13).

' For more information, see “Sample types for relative standard curve analysis” on page 26.
[l Each target requires its own standard curve.

3. Confirm or edit sample well assignments in the plate layout.

Add samples and assign to wells: comparative C; analysis

For detailed instructions about plate setup, see @ Help » Help Contents.

1. In the Plate Setup tab, add samples and assign to wells using the following options.

* Import a plate setup file
* Manually add samples to the Samples table

* Manually add samples to wells in the plate layout
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2 Chapter 3 Set up a plate file for relative quantification analysis
Confirm or edit the plate setup for relative quantification analysis

2. Confirm or edit sample information in the Samples table.

Column | Description

Name | Sample name

Color | Sample color

Typell | Comparative C; analysis uses the following sample types.

* Unknown—test and reference samples

Note: To identify a sample as the reference sample, see “(Optional) Edit relative
quantification analysis settings” on page 22

* Negative Control

' For more information, see “Sample types for comparative Ct analysis” on page 27.

3. Confirm or edit sample well assignments in the plate layout.

Set up the standard curve

Note:

. A standard curve is only required for relative standard curve analysis.

. Multiple targets can be assayed using relative standard curve analysis, but each target requires its
own standard curve.

. You can also set up the standard curve during sample setup (see “Add samples and assign to wells:
comparative Ct analysis” on page 11).

1. In the Plate Setup tab, in the plate setup pane, click --- (Actions) » Standard Curve Setup.
The Standard Curve Wizard opens.

2. In the Standard Curve Wizard pane, enter the sample name prefix.

3. Select the target for the standard curve.

Option Instructions
Target previously defined Select the target from the dropdown list.
Target not previously defined 1. Type the target name, the press Enter.

2. Select a reporter from the dropdown list.
3. Select a quencher from the dropdown list.

4. Adjust the parameters for the dilution series.
¢ Number of points—5 recommended
* Number of replicates —3 recommended
¢ Starting Quantity—The highest or lowest standard quantity, without units.

Note: The quantity must be greater than 0.

* Serial Factor
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Chapter 3 Set up a plate file for relative quantification analysis B
Confirm or edit the plate setup for relative quantification analysis

Note: The serial factor calculates quantities for all standard curve points.

— Starting quantity is the highest value—Select 1:10 to 1:2.
— Starting quantity is the lowest value—Select 2x to 10x.

5. Select an option to select the wells for the standard

* Select Automatically.
* Select Manually, then select wells using the displayed plate layout.

6. Select to arrange the standards in Rows or Columns.

7. Click Apply Standard Curve, then click Close to return to the Plate Setup tab.

Add targets and assign to wells

For detailed instructions about plate setup, see @ Help » Help Contents.

Note: Multiple targets can be assayed using standard curve analysis, but each target requires its
own standard curve. To set up the standard curve using the Standard Curve Wizard see “Set up the

standard curve” on page 12.

1. In the Plate Setup tab, add targets and assign to wells using the following options.

* Import an AlF file

* |Import a plate setup file

* |mport TagMan™ assay plate and card files

* Manually add targets to the Targets table

* Manually add targets to wells in the plate layout

2. Confirm or edit target information in the Target table.

Column Description
Name Target name
Color Target color
Task('! The software automatically assigns a task to the target in a well based on the
sample type in that well. The following tasks are used for relative quantification
analysis.

e Standard (relative standard curve analysis only)
¢ Unknown
* Negative Control

Quantity (standard | The quantity entered for a standard sample in the Samples table is used to
tasks only) populate the Quantity column for standard tasks in the Targets table.

' For more information, see “Sample types for relative quantification analysis” on page 26.

3. Confirm or edit target well assignments in the plate layout.
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2 Chapter 3 Set up a plate file for relative quantification analysis
Confirm or edit the plate setup for relative quantification analysis

Add biogroups and assign samples
Biogroups, or Biological Replicate Groups, are reactions that contain identical components and
volumes, but evaluate separate samples of the same biological source. Biogroups can be used in

relative quantification analysis.

1. In the Plate Setup tab, in the upper right pane, select an option to add biogroups:

Option Description
Add biogroups in the In the Samples table, enter the new biogroup name in the Biogroup
Samples table field.

The biogroup is added to the following locations:
e Samples table Biogroup dropdown list
* Biogroup table

Add biogroups in the

a. Click Biogroup.
Biogroup table

b. In the Biogroup table, click 4 (Add).

2. In the Samples table, for each sample in a biogroup, select a biogroup from the dropdown list.

3. (Optional) Edit the biogroup name or color.
a. Click Biogroup.

b. In the Biogroup table, click a field to edit.

Add a custom attribute to samples
1. In the Plate Setup tab, in the Samples table, click --- (Actions) » Add Custom Attribute.

2. In the Add Custom Attribute window, enter the custom attribute name, then click Done.

A column for the custom attribute is added to Samples table, and a new tab for the custom
attribute is created.

3. Select an option to define the choices for the custom attribute:

Option Description

Define in the Samples table |In the Samples table, define the custom attribute in the appropriate
field in the custom attribute column.

Define in the custom

a. Inthe custom attribute tab, click 4 (Add).
attribute tab

b. In the table, click in the field to edit the custom attribute name.

The custom attribute options are added to the following locations:
* Samples table, in the dropdown list in the custom attribute column
* Table in the custom attribute tab

4. Inthe Samples table, for each sample, select the custom attribute from the dropdown list.

14 QuantStudio™ Design and Analysis Software v2 Relative Quantification Analysis Module User Guide




Chapter 3 Set up a plate file for relative quantification analysis ~ [7a0%
Review and save the plate file

5. (Optional) Edit the custom attribute name or color.
a. Select the custom attribute tab.

b. In the table, click a field to edit.

Edit reagent information
1. In the Plate Setup tab, in the Targets/SNP Assays table pane, click Reagents.

2. In the Reagents table, click 4+ (Add).

Note:
. Click --- (Actions) » Export Reagents to export reagents.

. Click --- (Actions) » Import Reagents to import reagents.
. Click --- (Actions) » Scan Reagents to scan reagents.

3. Enter the following information for each reagent.

* Name * Part Number
* Type * Lot Number
* Barcode * Expiration Date

Note: If the master mix that you enter is not compatible with the current run method, you have
the option to apply the recommended run method for your master mix, instrument, block, and run
mode.

4. (Optional) Click X (Remove) in the row of a reagent to delete it from the table.

Select a passive reference

Editing the passive reference is a controlled function. If security has been enabled in the software, the
user role must have the permission of Edit Passive Reference.

1. In the upper-left corner of the Plate Setup tab, select a passive reference from the dropdown list.

2. (Optional) Save the plate file or data file.

Review and save the plate file

1. In the Run Summary tab, review the run method selections, then edit if needed.
2. Review the plate setup, then edit if needed.
3. (Optional) Click the barcode field, then scan the plate barcode.

4. (Optional) Select Add to My Plates.
This option allows you to create new plate files using the current plate file as a template.
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P2  Chapter 3 Set up a plate file for relative quantification analysis
Review and save the plate file

5. Select an instrument from the list.

If the instrument does not appear on the list, click £# System » Instruments to add a new
instrument.

6. Save the plate file.

Start the run on an instrument. For specifics on starting an instrument run, see the instrument
documentation.
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Perform relative quantification
analysis

Review results in the Amplification Plot

For detailed instructions about reviewing results in the Amplification Plot, see @ Help » Help
Contents.

If no data are displayed in the Quality Check tab, or if reanalysis is required, click Analyze.

1. In the Quality Check tab, in the plot pane, select Amplification Plot from the dropdown list.
2. Review the amplification status for each well.
3. Review or edit threshold settings.

4. Review or edit baseline settings.

Select the Relative Quantification Analysis Module

1. In an open data file, click Actions » Analysis Modules.

2. In the Analysis Modules window, select Relative Quantification, then click Ok.
The Relative Quantification Analysis Module opens.

Click Analyze, then review the results in the Relative Quantification tab.

Review results in the Standard Curve Plot

1. In the Relative Quantification tab, in the plot pane, select Standard Curve dropdown list.

2. In the plot pane, click £}, then select an option from the Color By dropdown list: Target, Sample,
or Task.

The Standard Curve Plot is displayed. The target, slope, R? value, Y-intercept, amplification
efficiency, and error are displayed below the plot.

3. Confirm that the slope, R? value, amplification efficiency, and error meet the analysis criteria.
For more information, see “Standard Curve Plot overview” on page 28.
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7R  Chapter 4 Perform relative quantification analysis
Review results in the Gene Expression Plot

4. Visually check that all unknown sample Cgq values fall in the standard curve range.

5. In the Well Table, confirm that the Cq values of all replicate samples meet the analysis criteria (see
“Review the results in the Well Table” on page 20).

If the results do not meet the analysis criteria, troubleshoot using one of the following strategies:

* Omit wells, then reanalyze (see “(Optional) Omit outliers from relative quantification analysis” on
page 21).

* Repeat the plate run, adjusting plate file setup and analysis settings to improve results.

Review results in the Gene Expression Plot
For more information about the Gene Expression Plot, see “Gene Expression Plot overview” on
page 30.
1. In the Relative Quantification tab, in the Result Type pane, select an option for data analysis:
* Sample
* Biogroup

2. In the plot pane, select Gene Expression Plot from the dropdown list.

3. Click ¥ (Settings) to select an option from the Plot Type dropdown list.

* RQ vs Sample
* RQ vs Target
¢ RAQ vs Biogroup

Note: This option is only available for Biogroup analysis (see step 1).

4. Review the Gene Expression Plot to evaluate the fold change in expression level of the targets of
interest in the test samples or biogroups relative to the reference sample or biogroup.
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Chapter 4 Perform relative quantification analysis ~ [/

(Optional) Review results in the Endogenous Plot

(Optional) Review results in the Endogenous Plot

For more information about the Endogenous Plot, see “Endogenous Plot overview” on page 31.

Select the endogenous controls for analysis (see “(Optional) Edit relative quantification analysis
settings” on page 22).

1. In the Relative Quantification tab, in the plot pane, select Endogenous Plot from the dropdown
list.

2. Review the Endogenous Control Profile.

3. (Optional) To change the endogenous controls used for analysis, select £ Analysis
Settings » Relative Quantification Analysis Setting (see “(Optional) Edit relative quantification
analysis settings” on page 22).

4. Click Analyze to see the result using the updated analysis settings.

QuantStudio™ Design and Analysis Software v2 Relative Quantification Analysis Module User Guide
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Chapter 4 Perform relative quantification analysis

Review the results in the Well Table

Review the results in the Well Table

* |n the Relative Quantification tab, review the results in the Well Table.

Column Description
Target Target name
Sample Sample name
The Equivalent Cq Mean is the arithmetic average of the Equivalent C, values for technical
replicates.
Equivalent C, values are calculated to adjust for differences in PCR efficiency among individual
targets within the relative quantification analysis. If the target efficiency set to less than 100% in the
EqCq Mean | Relative Quantification Analysis Settings, then the Equivalent C, for a target is calculated as if the
PCR efficiency was 100%!"].
Note: The C4 Mean values in the Quality Check tab are not affected by the target efficiencies
entered in the Relative Quantification Analysis Settings.
The Adjusted EqC4 Mean is the Equivalent Cq Mean adjusted based on the Maximum Allowed C
Adiusted Mean limit defined in the Relative Quantification Analysis Settings!?l.
u
EqCJ Mean If this is included in the relative quantification calculation, wells with C scores greater than the
q maximum allowed value are adjusted to the specified Cq limit. Otherwise it is undetermined and it is
not included in the relative quantification calculation.
AEQC, Mean is the arithmetic average of the technical replicate Equivalent C, values for the sample
replicate group.

AEQC, Mean | Note: The AEQC, mean is calculated at the reaction plate level and represents the mean difference
between the target C, values and the endogenous control C, values for all the technical replicates
for that sample that are present on the plate.

AEQC, SE is the standard error of the sample-replicate-group-level Equivalent Cq values.
Note: The AEQC, SE value is calculated differently for multiplex and singleplex experiments. For
AEQC, SE | multiplex experiments, the calculation is at the well level. For singleplex experiments, the calculation
combines the plate-level Equivalent C, value variation between the target and the endogenous
control.
AAEQC, is the fold change between the EqC, values for a replicate group sample and the reference
AAEACq sample.
RQ The calculated relative level of gene expression for the replicate group that is associated with the
test sample.
View the minimum relative level of gene expression in the test samples calculated using the
confidence level set in the analysis settings.
RQ Min
Note: The minimum includes the variability associated with the endogenous control and targets in
only the test samples.

20
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Chapter 4 Perform relative quantification analysis [/
(Optional) Omit outliers from relative quantification analysis

(continued)
Column Description
View the maximum relative level of gene expression in the test samples calculated using the
confidence level set in the analysis settings.
RQ Max : . . . . :
Note: The maximum includes the variability associated with the endogenous control and targets in
only the test samples.

1 Adjust a target efficiency in the Endo Controls tab of the Relative Quantification Analysis Settings (see “(Optional) Edit relative quantification
analysis settings” on page 22).

[l Adjust the Maximum Allowed Cq4 Mean in the General tab of the Relative Quantification Analysis Settings (see “(Optional) Edit relative
quantification analysis settings” on page 22).

(Optional) Omit outliers from relative quantification analysis

Outlier wells have C values that differ significantly from the average for the associated replicate wells.
To ensure Cq precision, consider omitting the outliers from analysis.

1. In the Quality Check tab, in the Well Table, select Omit in the row of the outlier well.

2. Click Analyze to reanalyze the data with any outliers removed.

(Optional) Review dye signal profile in the Multicomponent
Plot

For more information about the Multicomponent Plot, see ? Help » Help Contents.

If no data are displayed in the Quality Check tab, or if reanalysis is required, click Analyze.

1. In the Quality Check tab, in the plot pane, select Multicomponent Plot from the dropdown list.
2. Review the signal profiles for the passive reference dye, reporter dye, and negative control wells.

3. Review the plot to ensure that there are no irregularities in the dye signals.

(Optional) Review signal profile in the Raw Data Plot

For detailed instructions about reviewing results in the Raw Data Plot, see » Help » Help Contents.

If no data are displayed in the Quality Check tab, or if reanalysis is required, click Analyze.

1. In the Quality Check tab, in the plot pane, select Raw Data Plot from the dropdown list.

2. Click-drag the Cycle Number slider through all of the cycles, then confirm that each filter displays
the characteristic signal increase.
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@#¥%  Chapter 4 Perform relative quantification analysis
(Optional) Edit relative quantification analysis settings

(24

(Optional) Edit relative quantification analysis settings

* We recommend that you analyze data with the default analysis settings. Edit the default analysis
settings for analysis of unexpected run data, then reanalyze the data.

* For more information about analysis settings, see @ Help » Help Contents.

Open the Relative Quantification Analysis Module.

1. Click Actions » Relative Quantification Analysis Setting.

2. In the General tab, edit the analysis settings if needed.

Parameter

Description

RQ Min/Max
Calculations

Select the algorithm used to calculate the relative quantification minimum and
maximum values (error bars).

* Confidence Level—Select to calculate the RQ minimum and maximum
values based on the selected confidence level.

¢ Standard Deviation—Select to calculate the RQ minimum and maximum
values based on the selected number of standard deviations.

Maximum Allowed

Turn on to automatically use the target that exceeds the designated C, value as

Cq Mean the default for analysis.
Maximum Allowed C, Mean is used to calculate the Adjusted EqC, Mean (see
“Review the results in the Well Table” on page 20).

Analysis Type Select Singleplex or Multiplex analysis.

3. In the Endo Controls tab, select the Normalization Type.

normalization

Option Description
Specific . - .
Select to specify one or more specific targets for use as endogenous controls in
endogenous .
your analysis
controls
Select to have the software algorithmically normalize the C, scores for the relative
quantification calculation.
The global normalization option can be useful when analyzing data in which the
Global amount of input RNA varies significantly from sample to sample. When configured

for global normalization, the software first finds assays common to every sample in
the analysis and then uses the median C,, of those assays as a normalization factor,
on a per sample basis

Note: Global normalization is not supported for multiplex analysis.

Skip
normalization

Select to calculate the direct AC, of the test and calibrator samples by omitting the
intermediate target normalization step from the relative quantification calculation.
By skipping normalization, the normalized quantities in the analyzed data reflect the
fold change indicated between two samples directly.

Note: We recommend target normalization for most analysis.
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Chapter 4 Perform relative quantification analysis S8
Export the results

4. (Optional) If using specific endogenous controls, select the normalization preference for the
targets.
5. (Optional) To adjust the target efficiency, enter a new value in the Efficiency field.
Note: Target efficiency is used to calculate Equivalent C, values (see “Review the results in the
Well Table” on page 20). If the target efficiency set to less than 100, then the Equivalent C, for a
target is calculated as if the PCR efficiency was 100.
6. In the References tab, edit the analysis settings if needed.
Parameter Description
Group Category (Optional) Select the biogroup!'! or custom attribute from the dropdown list.
Reference Group Select the reference group from the dropdown list.
Reference Sample | Select the reference sample from the dropdown list.
0" Only required for biogroup analysis.
7. Click Apply.

The data are reanalyzed using the updated analysis settings.

Export the results

1.

In the table pane, click --- (Actions) » Export.

2. (Optional) In the Export CSV dialog box, edit the file name in the File Name field.

The File Name field is populated with a default file name.

Click Browse to select a location to save the file.

Selecting the location where the file is saved is a controlled function. If the Browse button in the
Export CSV dialog box is inactive, the security has been enabled in the software. The user role
does not have the permission to select the location where the file is saved. The user role must have
the permission of Edit Export Destination.

4. Click Export.
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About relative quantification analysis

Relative quantification analysis is used to determine the relative quantity of a target of interest in a test
sample relative to a reference sample. You can use relative standard curve analysis or comparative C;
analysis for relative quantification (see “Relative quantification: relative standard curve vs. comparative
Ct” on page 25).

Relative quantification analysis is commonly used for the following applications.
* Comparison of expression levels of a gene in different tissues.
* Comparison of expression levels of a gene in a treated sample vs. an untreated sample.
* Comparison of expression levels of a gene of interest in different genetic backgrounds.
* Analysis of the gene expression changes over time under specific treatment conditions.

Overview of relative standard curve analysis

For relative standard curve analysis, the software performs the following tasks.

1. The software measures amplification of the target of interest and of an endogenous control target
in a standard dilution series, in a reference (calibrator) sample, and in test samples.

The endogenous control is a target that is expressed equally in all samples; examples

of endogenous controls are B-actin, GAPDH, and 18S ribosomal RNA. The software

can algorithmically incorporate multiple endogenous control targets in relative quantification
calculations.

The reference sample is used as the basis for relative quantification results (or 1x sample). For
example, in a study of drug effects on gene expression, an untreated control is an appropriate
reference sample.

2. The software generates standard curves for the target of interest and the endogenous control using
data from the corresponding standard dilution series.

3. The software uses the standard curves to adjust the Cq value of each target proportionally to
achieve equivalent target efficiencies.

4. The calculated equivalent Cq values for the target of interest are normalized to the endogenous
control.

5. To determine the relative quantity of the target in test samples, the software compares the
normalized AGC,, for the sample to the normalized AC,, for the reference sample.

For a comparison of relative standard curve analysis to the comparative C; (AAC;) analysis, see “Relative
quantification: relative standard curve vs. comparative Ct” on page 25.
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Overview of comparative Ct analysis

Overview of comparative C; analysis

For comparative C; analysis, the software performs the following tasks.

1.

The software measures amplification of the target of interest and of an endogenous control target
in a reference (calibrator) sample and in test samples.

The endogenous control is a target that is expressed equally in all samples; examples

of endogenous controls are B-actin, GAPDH, and 18S ribosomal RNA. The software

can algorithmically incorporate multiple endogenous control targets in relative quantification
calculations.

The reference sample is used as the basis for relative quantification results (or 1x sample). For
example, in a study of drug effects on gene expression, an untreated control is an appropriate
reference sample.

The measurements for the target of interest are normalized to the endogenous control.

3. To determine the relative quantity of the target in test samples, the software compares the

normalized AGC,, for the sample to the normalized AC, for the reference sample.

For a comparison of comparative C; analysis to relative standard curve analysis, see “Relative
quantification: relative standard curve vs. comparative Ct” on page 25.

Relative quantification: relative standard curve vs.
comparative C;

Characteristic Relative standard curve Comparative C;

Typical use Best for assays that have Best for high-throughput measurements of relative gene
suboptimal PCR efficiency. expression of many genes in many samples.

Advantage Requires the least amount of * Relative levels of target in samples can be determined
validation because the PCR without the use of a standard curve, if the PCR
efficiencies of the target and efficiencies of the target and endogenous control are
endogenous control do not need to relatively equivalent.
be equivalent. ¢ Reduced reagent usage.

* More space available in the reaction plate.

Limitation

A standard curve must be ¢ Suboptimal (low PCR efficiency) assays may produce
constructed for each target, which inaccurate results.

requires more reagents and more * Before you use the comparative C; method, we

space in the reaction plate. recommend that you determine that the PCR efficiencies

for the target assay and the endogenous control assay
are approximately equal.
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Sample types for relative quantification analysis

Sample types for relative standard curve analysis

Relative standard curve analysis includes the following reaction types for the endogenous control target
and each target of interest.

Sample type

(Type column in

Sample description

Automatic target task
assignmentl']

(Type column in

SRR k) Targets table)
Standard A sample that contains known or known relative quantities | Standard
of the target and is used to generate standard curves
* For known quantities—quantify the target in the
standard sample using an independent method.
* For known relative quantities—generate a relative
dilution series of the target standards.
Unknown Test sample Unknown

Reference sample—The sample that is used as the basis for
relative quantification resultsl?

No-template control
(NTC/ Negative
Control)

Water or buffer

No amplification of the target should occur in NTC wells.

Negative Control

' The software automatically assigns a task to the target in a well based on the sample type in that well.

[ To identify a sample as the reference sample, see “(Optional) Edit relative quantification analysis settings” on page 22.

* The precision of quantification experiments improves as the number of replicate reactions
increases. Set up the number of replicates appropriate for the analysis.

* Set up the standard dilution series with at least five dilution points over a broad range of standard
quantities, 4 to 6 logs (10%- to 10%-fold). For best results, use a concentrated template, such as a
plasmid or PCR product.

A narrow range of standard quantities can be used if the standard amount is limited, the target is in
low abundance, or the target is known to fall in a given range.
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Sample types for comparative C; analysis

Comparative C; analysis includes the following sample types for the endogenous control target and
each target of interest.

Sample type Automatic target task
(Type column in Samples Sample description assignment!t
table) (Task column in Targets table)
Unknown Test sample Unknown

Reference sample—The sample that is used
as the basis for relative quantification
resultsl?l

No-template control (NTC/ | Water or buffer Negative Control

Negative Control) No amplification of the target should occur in

NTC wells.

' The software automatically assigns a task to the target in a well based on the sample type in that well.
[ To identify a sample as the reference sample, see “(Optional) Edit relative quantification analysis settings” on page 22.

The precision of quantification analysis improves as the number of replicate reactions increases. Set up
the number of replicates appropriate for your analysis.
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Plots

Standard Curve Plot overview

The Standard Curve Plot displays the standard curve for samples designated as standards. The
software calculates the quantity of a target in an unknown sample using the standard curve.

30

Cq

20

T T T T T T T T T T T = T T T T T |

Tes1 Te+2 1242 Te+d Te+s 1e+6 Te+T 1248 e+l 1e+10
Quantity

Target: KAZ Slope:-3.319 R*0.999 Y-nter: 33.239 Eff: 100.140 Error: 0.004

Figure 1 Example Standard Curve Plot
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Table 1 Results or metrics to review in the Standard Curve Plot

at which the fluorescence level
meets the threshold.

Result_s or Description Criteria for evaluation
metrics
Slope and The amplification efficiency is A slope close to —3.3 indicates optimal, 100% PCR
amplification calculated using the slope of the | amplification efficiency.
efficiency :’;gr:zssmn line in the standard Factors that affect amplification efficiency:
' * Improper design of the primer and probe

* Range of standard quantities—For accurate and precise
efficiency measurements, use a broad range of standard
quantities, 5 to 6 logs (105- to 108-fold).

* Number of standard replicates —For accurate efficiency
measurements, include replicates to decrease the effects
of pipetting inaccuracies.

* PCR inhibitors—PCR inhibitors and contamination in the
reaction can reduce amplification efficiency.

® Other possible factors:

— Component and properties of the reaction mix, such
as salt content, DMSO, pH, etc.
— Inaccurate sample or reagent pipetting
— Improper analysis settings
— Incorrect plate setup
R2 value The R2 value is a measure of * Avalue of 1.00 indicates a perfect fit between the
(correlation the closeness of fit between the regression line and the data points.
coefficient) regression line and the individual | ¢ An R2 value > 0.99 is desirable.
C4 data points of the standard
reactions.
Error The standard error of the slope | Acceptable value is determined by the analysis criteria.
of the regression line in the
standard curve.
The error can be used to
calculate a confidence interval
(CI) for the slope and therefore
the amplification efficiency.
Cq values Cyq is the PCR cycle number A Cq value > 8 and < 35 is desirable.

Cq value < 8—There may be too much template in the
reaction.

Cq value > 35—There may be a low amount of target in
the reaction; for Cq values > 35, expect a higher standard
deviation.

QuantStudio™ Design and Analysis Software v2 Relative Quantification Analysis Module User Guide 29



@ Chapter 5 About relative quantification analysis

Plots

Gene Expression Plot overview

The Gene Expression Plot displays the fold change in the target expression levels in test samples
relative to the reference sample.

There are three gene expression plots available, depending on the analysis type.

Plot type

Description

RQ vs. Target

Groups the relative quantification (RQ) values by target. Each sample is plotted for each
target.

RQ vs. Sample

Groups the relative quantification (RQ) values by sample. Each target is plotted for each
sample.

RQ vs. Biogroup

Groups the relative quantification (RQ) values by biogroup. Each target is plotted for each
biogroup.
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Figure 2 Example Gene Expression Plot

In this example, there is one target of interest, and the reference sample (calibrator) is sample 400.
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Plots

Endogenous Plot overview

The Endogenous Plot is a visual display of the Cq values of potential endogenous control targets
across all samples (endogenous control profile).

Use the Endogenous Plot to choose the best endogenous control for your analysis. Select the target
with a quantity (indicated by Cq value) that does not change under experimental conditions.

All targets can be displayed in the Endogenous Plot. You can view up to four potential endogenous
controls at a time.

Endogenous Control Profile
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Sample
o Target M internal Positive Control (IPC)

Figure 3 Example Endogenous Plot
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Documentation and support

Related documentation

Document Publication number
QuantStudio™ Design and Analysis Software v2 User Guide MANO0018200
QuantStudio™ Design and Analysis v2 User Guide (Thermo Fisher™ Connect Platform) MANO0018202

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.

* Worldwide contact telephone numbers

* Product support information
— Product FAQs

— Software, patches, and updates
— Training for many applications and instruments
* Order and web support

* Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the

manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the
Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at

www.thermofisher.com/support.
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